
Step by step guide to downloading Mozilla 
Firefox web browser and Video 
DownloadHelper for Windows and 
Macintosh. 
 
From your default browser either search from Google or other search engine for ‘mozilla 
firefox’ or in the address bar type in  ‘http://www.mozilla.com’ and hit enter. 
 
This is the screen that should appear 
Select ‘Download Firefox – Free’ 
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An instruction page appears.  
Select ‘Save’ from the File Download – Security Warning window. 

 
 
Select ‘Next’ to continue 

 
 
 

PENT Forum 2009 Section 5 
Page 2 of 20



Select the ‘I accept the terms in the license Agreement’ box then select ‘Next’ 

 
 
Selecting ‘Standard’ is sufficient. 
If you want to use Firefox as your default web browser select ‘Use Firefox as my default 
web browser’.  
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If not make sure the box is unchecked. 

 
 
Select ‘Install’ to continue with installation. 

 
 

PENT Forum 2009 Section 5 
Page 4 of 20



Select the ‘Launch Firefox now’ box and select ‘Finish’ 

 
You have the option to import your bookmarks, history and passwords from Internet 
Explorer.   
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When Firefox starts up the ‘Default Browser’ box will continue to appear unless the 
checkbox is cleared. 

 
 
Firefox is now loaded and can be used as any other browser. 
The welcome page is available with links to get familiar with the program. 
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Now to get the reason we installed Firefox in the first place, Video downloadhelper. 
Select ‘Add-ons’ under tools’ and search for ‘downloadhelper’ in the search box. 

 
 
When the ‘Video Downloadhelper’ window opens select ‘Add to Firefox’. 
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Select ‘Install Now’ 

 
 
Select ‘Restart Firefox’ to complete the installation. 

 
 
 
 
 

PENT Forum 2009 Section 5 
Page 8 of 20



Upon restart the Video DownloadHelper page will appear. 
The 3 connected spheres to the left of the ‘Home’ icon indicates Video DownloadHelper 
is installed. 
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Video Conversion Feature 
DownloadHelper's primary job is to retrieve to your disk the videos that are playing in 
Web pages, in their original format. 

Unfortunately, the native format (generally FLV) is often not very convenient when it 
comes to playing back the videos, on either your home computer or a hand held device, 
burning them to a DVD or reworking the movie. 

With the new DownloadHelper's Video Conversion feature, you can very easily select 
one or more videos that lie on your disk and choose a pre-defined output format. The 
program will process the movies in background. 

Even better: you can setup the extension to automatically convert the videos as soon as 
they are saved by DownloadHelper. You can even specify conversion rules (which site, 
which original media format) to be processed with a given set of parameters. 

Video conversion is available on DownloadHelper 3.1 or later. 

Installing the feature (This part of the installation guide comes from the Video 
DownloadHelper site.) 

Installing on Windows 

Using video conversion with DownloadHelper requires that you turn on the feature from 
the extension's preferences dialog. 

The simplest way to open the preferences is to right click on the DownloadHelper icon 
and select the first entry 'Preferences'. If the icon is not installed in the toolbar, the 
preferences can also be opened from the Tools / DownloadHelper / Preferences menu, or 
Tools / Add-ons menu, DownloadHelper selection, Preferences button. From the 
preferences window, the tab Conversion must be selected. 

 

The Conversion enabled input must be checked. 
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The message in red indicates that ConvertHelper, the external program in charge of the 
conversion job, has not been found on the system. Clicking on the Install/Update 
converter button takes the user to a page where a ConvertHelper installation program can 
be downloaded from. 

Installing ConvertHelper is an easy job: 
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Once ConvertHelper is installed, click on the Re-check Converter button or reopen the 
preferences. 
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Video conversion is ready to be used. 

 

Installing on Linux or  Mac 

For  Linux and Mac, we do not have a specific FFMPEG distribution to connect to 
DownloadHelper. Instead, the conversion relies on the distribution that has been installed 
separately on the computer. Of course, this can lead to conversion failures as the version 
of FFMPEG may not have been compiled with the features required by the chosen 
conversion parameters. This might be the case, for instance, when converting to MP3 
format, as the native FFMPEG may not have this feature for legal reasons. 

On Linux Ubuntu, you may install FFMPEG with: 

sudo apt-get install ffmpeg 

Or better, recompile FFMPEG with more features. 

PENT Forum 2009 Section 5 
Page 13 of 20



 

You can specify the exact location of the FFMPEG executable in the preferences. 

Note that you can also use Mencoder as an alternative to FFMPEG. However, all the 
defined conversion parameters will simply be ignored. 

Using the feature 

Converting manually 

Manual conversion allows the user to choose a set of video files from the standard File 
open dialog, and to indicate what output format is desired. The program takes care of 
doing the conversion job. 

Right-click on the DownloadHelper icon and choose Convert videos. A file chooser 
dialog opens. 
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Several files can be selected by holding the CTRL or SHIFT key while clicking on the 
file name. 

You can also request a video conversion at the same time you request the download of 
the video. For doing this, hold the SHIFT key while clicking on the entry in the download 
menu. 

Then, the user is prompted for the desired output format. 

 

In the basic usage of the conversion feature, the user chooses a pre-defined format in the 
drop-down list and click OK. Conversion will start immediately. 

For advanced users, it is possible to tune many parameters of the conversion. Clicking 
Details opens a new dialog. 
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The most common conversion parameters are displayed. To be used, the corresponding 
checkbox must be checked, otherwise, the default applies. 

Conversion parameters are dispatched within 2 tabs. The Advanced tab holds a special 
Extra parameters input to be used as FFMPEG arguments when the corresponding 
parameter is not listed in the user interface. 
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If the 2 Passes checkbox is active, the user can specify independantly the parameters for 
each pass. By default, the second pass uses the same parameters as the first one. When 
using 2 passes conversion, the input file is first processed to gather statistics on the audio 
and video streams, then the file is converted in the second pass with optimal tuning, 
leading to a better quality and/or a reduced size. This is of course at the price of a longer 
execution. 

 

Converting automatically 

It is possible to specify that conversion should occur automatically. By default, when the 
conversion feature is enabled, the downloaded FLV files are automatically converted to 
AVI. This is done using the default conversion rule. This rule can be edited to indicate a 
different format or parameters. Selecting the rule from the preferences dialog / 
conversion tab, and clicking button Edit rule opens the rule editor. 

 

If the user needs to convert differently depending on the site he/she is accessing to, or the 
format of the original media files, it is possible to create several rules, that will be 
checked in order. 

Button Revert to default removes all defined rules and re-create the default one. 
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Add a movie or animated GIF to a 
PowerPoint slide 
"Movies" are desktop video files with formats such as AVI, QuickTime, and MPEG, and file 
extensions such as .avi, .mov, .qt, .mpg, and .mpeg. An animated GIF file always has a .gif file 
extension. 

1. Display the slide to which you want to add a movie or animated GIF.  
2. Do one of the following:  

Add a movie or animated GIF file 

1. On the Insert menu, point to Movies and Sounds, click Movie from File, locate 
the folder that contains the file you want, and then double-click the file.  

Note   A movie or .gif file that you've added to Clip Organizer is found in the 
Clip Organizer folder within the My Pictures folder on your hard disk. Or, go to 
the original location for these files.  

2. When a message is displayed, do one of the following:  
 To play the movie or GIF automatically when you go to the slide, click 

Yes.  
 To play the movie or GIF only when you click it, click No.  

Note   If you try to insert a movie and you get a message saying that Microsoft 
PowerPoint can't insert the file, try inserting the movie to play in Windows Media Player. 

3. In Windows, launch Windows Media Player (from the Start button, on the 
Accessories submenu).  

4. On the File menu in Windows Media Player, click Open, and then type the path 
or browse for the file you want to insert, and click OK.  

 If the movie opens and plays, complete the remaining steps in this task.  
 If the movie cannot play, then it won't play when you open the Windows 

Media Player in PowerPoint, so don't complete this task. You can consult 
Windows Media Player Help to try to troubleshoot the problem. Also, in 
PowerPoint, search on "Troubleshoot movies" in the Ask a Question box 
on the menu bar to get more suggestions.  

5. Display the slide you want the movie on in PowerPoint, and on the Insert menu, 
click Object.  

6. Under Object Type, click Media Clip, and make sure Create new is selected. If 
you want the movie to display as an icon, select the Display as icon check box.  

7. Click OK.  
8. On the Insert Clip menu in Windows Media Player, click Video for Windows.  
9. In the Files of type list, select All Files, select the file, and then click Open.  
10. To play it, click the Play button just below the menu bar, on the upper left; to 

insert it onto your slide, click outside the movie frame.  
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Attention Mac Users 
Playing Windows Media Files on QuickTime 

Yes, you can play a WMV file on your Mac. With the recent release of Windows Media 

Components for QuickTime, you can play Windows Media audio and video files (WMA, 

WMV) directly in the QuickTime Player and also view Windows Media content on the 

Internet using a Web browser. 

Flip4Mac WMV is comprised of a collection of QuickTime™ components that enables 

Mac OS X users to play, import and export Windows Media files using QuickTime-based 

applications. Both the PowerPC and Intel-based Macintosh systems are supported, on 

Mac OS X version 10.3.9 and QuickTime version 6.5 or later. 

You can download Flip4Mac WMV (http://www.flip4mac.com/wmv.htm )free of charge, 

and if you purchase an upgrade, you can import Windows Media files for editing, create 

Windows Media files for distribution, and export to other formats. Note that this product 

does not support files that are protected with Windows Media digital rights management 

(DRM).  

Windows Media Player for Mac? 

Another option is to download the Windows Media Player for Mac from the Microsoft 

website. 

Microsoft says they will continue to offer Windows Media Player version 9 as a free 

download for Macintosh users, but they will no longer provide support or updates for this 

product. So in the long run, you may be better off going with the Flip4Mac WMV addon 

for QuickTime. 
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Editing Movies 
 
Below are the two easiest editors for movies with associated links for tutorials. 
 
A little bit of time working through the tutorials will save a lot of time and frustration by 
learning the basics. 
 
 
For Windows 
Windows Movie Maker   
 
 Tutorial 
 http://www.microsoft.com/windowsxp/using/moviemaker/default.mspx 

 
For Macintosh 
iMovie 
 
 Tutorial 
 http://www.apple.com/ilife/imovie/ 
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